Quick start guide

Jedli is a data mining tool box, designed to get more out of digitized Arabic texts.

Getting started with Jedli:

1. Download the zipped Jedli archive from the website:
2. Unzip the Jedli archive and save the Jedli folder on your computer
3. In the Jedli folder, double-click the jedli_main.exe file to launch the program. When you launch it the first time, Jedli might take around a minute to install itself.

Jedli currently contains three main tools:

- The Indexer: creates customized index files for any number of words in any number of sources.
- The Highlighter: highlights the words the user provided in a text, in order to facilitate retrieving relevant information from lengthy texts; different colors can be used for different (sets of) search terms, allowing the user to create personal color schemes.
- The Context Search: allows you to limit your search results to relevant contexts, based on user-defined checklists.

This is the first version of Jedli, more tools will be added later to the tool box.

The advantages of Jedli over other tools:

- checklists of search terms: you can create lists with an unlimited number of search terms, which you can use repeatedly for search operations.
- allows you to use separate, highly customizable search options for each search term.
- allows you to create your own source selections (based on genres, time periods, …).
- allows you to save all your search results.

Jedli comes with a small number of sample texts; more texts can be added by the user (see the manual).
Contents

Quick start guide ................................................................................................................................. 1
A guided tour through the Jedli tool box .............................................................................................. 3
  1. Selecting the search terms .............................................................................................................. 5
  2. Selecting search options ................................................................................................................. 6
    Regular Expressions (Regex) .................................................................................................................. 7
  3. Selecting sources ............................................................................................................................. 9
    Jedli and al-Maktaba al-Shamela ...................................................................................................... 10
  4. Selecting the output folder for the search results ........................................................................... 10
  5. The Indexer ...................................................................................................................................... 11
  6. The Highlighter ............................................................................................................................... 12
    Examples for the use of the Highlighter ............................................................................................. 13
  7. The Context Search .......................................................................................................................... 14
    Using the Context Search ................................................................................................................... 14
  8. The menu bar .................................................................................................................................... 16
    a. Load and save search parameters ............................................................................................... 16
    b. Default settings ............................................................................................................................ 16
    c. Adding new sources to the source list .......................................................................................... 18
      Batch download texts from the Jedli website .................................................................................. 18
      Select specific texts for download from Jedli’s “Download” window ............................................ 19
      Download texts from al-Maktaba al-Shamela and convert them .................................................. 20
      Add texts from other sources .......................................................................................................... 20
        Volume and page numbers ........................................................................................................... 21
A guided tour through the Jedli tool box

The main window of the Jedli tool box contains four key elements:

1. the menu bar
2. the “search term” frame
3. the “input and output” frame
4. the frames for the three main Jedli tools: the Indexer, the Highlighter, and the Context Search

For any search, you should select

1. one or more search terms,
2. one or more sources you want to search,
3. a folder where the results of your search will be saved,
4. and the type of search you want to carry out.
Upon launching the program, a second window appears next to the main window: the Jedli logger. In this window, you can follow what the program is doing.

You can close the logger if you do not need it and re-open it at any time by clicking “Display Jedli Logger” in the View menu:
1. Selecting the search terms

There are a couple of ways to select search terms in Jedli:

a. You can simply type a search term (in Arabic) in the entry fields. Search terms can consist of one or more words. Clicking the “Add more search words” button will give you more entry fields to add search terms:

![Image of search term input fields]

The Boolean operators AND, OR and NOT are only used for the Context Search tool. For more about the use of these operators, see below.

b. In each entry field, you can type more than one search term, divided by a hyphen ("- "). In the example above, Jedli will search for البصرة in combination with either فارس or بحر فارس.

NB: take care not to include additional spaces between the search terms and the hyphens.

c. You can also employ user-defined checklists of search terms. These checklists are simple text documents (.txt files) that contain one search term on every new line (for more on checklists, see below):

![Image of checklist file]

You can open a checklist by clicking the “select checklist” button. This will open a standard “open file” dialog from which you can select your checklist.
2. Selecting search options

For every (list of) search term(s), you can define specific search options by clicking the “search options” button.

This will open the following pop-up window (NB: the “custom” fields are unfolded only when “custom” is selected):

Arabic words can have prefixes and suffixes, and a number of enclitic particles and conjunctions, which have to be taken into account when conducting a search.

In the left-hand part of the “search options” window, you can define how Jedli deals with these.

You can opt for a simple search, which will simply look for the chain of characters of your search term, no matter what precedes or follows these characters. This might be useful (e.g., if you are searching for فارس, you might also be interested in someone who is called الفارسي), but it may lead to undesired results (e.g., if you are searching for كرة, you will also get results for مذكرة).
In the other extreme ("super strict" search), you can tell Jedli to disregard all results where your search words are preceded or followed by any other character.

You can also define which characters should be allowed to precede and follow your search terms. Jedli groups these options in logical combinations (all, nominal, verbal), but you can also pick the prefixes and suffixes you want to allow ("custom").

Another annoyance for searches in Arabic are alternative and defective spellings. On the right-hand side of the screen, there are check boxes for additional search options that allow you to deal with three of the most common issues:

- **alifs**: since *hamzas* and *maddas* are not consistently written, it is often wise to disregard them.
- **tā’ marbūṭa** and final hā’: in some (rare) cases, the dots on the tā’ marbūṭa are omitted.
- **final yā’ and alif maqṣūra**: the final yā’ is sometimes written without its dots, and alif maqṣūra with dots.

Ticking the check boxes will tell the program to match each of the alternatives. E.g., if you search for ﻃﻼﺒﺮﻲ, both الطبري, الطبري will show up in your results.

---

**Regular Expressions (Regex)**

For the search options, Jedli uses regular expressions. A regular expression is a sequence of characters that defines a pattern. This pattern can be used to search, select, and replace sequences of characters in a text.

For example, if we want to find the word "color" in a text, but we do not know whether it is written in American or British spelling, we can use the following regular expression to match both forms:

```
colou?r
```

The question mark indicates that the preceding token (i.e., the “u”) is optional. Therefore, both "colour" and "color" will match this pattern and turn up in the results.
When clicking the “show regexes and sample search” button, two new frames appear:

- Underneath the button, the regular expressions that will be used for the search are indicated. You can also write your own regular expressions here.¹
- In the new column to the right of the button, you can see the effect of your search options on three sample search words.

Changing your search options will change the regular expressions and the search results.

¹ For more on regular expressions for searching Arabic texts, see José Haro Peralta and Peter Verkinderen: “Find for me!”: Building a context-based search tool using Python”, in Elias Muhanna (ed.), The Digital Humanities and Islamic & Middle East Studies, Berlin (De Gruyter): forthcoming.
3. Selecting sources

To select sources in which to search, click the “select source(s)” button in the “input and output” frame. This will open the source selection pop-up window.

By default, the table in “select your sources” contains all the sources in Jedli’s “sources” folder (for more on adding sources to your sources folder, see below).

You can filter the sources displayed here by filling in one or more of the filter fields in the top part of the window (“Author”, “Title”, “Genre”, and “Dates”) and clicking the “apply filters” button. The “clear all” button deletes the input in all entry boxes and returns all sources to the “select your sources” table.

You can select a source by clicking on it; multiple sources can be selected at the same time by keeping the Ctrl or Shift key pressed while clicking. To move your selection of sources to the “selected sources” list, click the “>” button. You can move the entire list of sources in the left-hand table to the selected sources list on the right by clicking the “>>” button.

To remove sources from the selected sources list, click them and hit the “<” button; or use the “<<” button to remove all sources from the list.

When you are done selecting sources, click the “confirm selection” button to return to the main Jedli window and conduct a search in the selected sources, which will be displayed in the main Jedli window.

If you are going to use this same selection of sources more often, you can save your selection by clicking the “save selection for later” button. You will be prompted to provide a name for your selection.

The next time you use Jedli, your selection will be in the “my selections” drop-down menu in the filter field.
4. Selecting the output folder for the search results

The search results from the Jedli tools are saved to your computer as html files, which you can open in any web browser. By default, Jedli saves the html files to its “search results” folder. If you want to save the search results in another folder, click the “change output folder” button in the “input and output” frame. This will open a dialog window that lets you select the folder of your choice:

For more on how to change the default folder for your search results, see below.
5. The Indexer

The Indexer creates an index (volume number and page number) for any of your search terms in every source you have selected. Simply click the “index it!” button to run the tool.

The page numbers are links; if you click them, you are taken to the relevant page of the book on the Shamela website. Clicking on the book title will bring you to the book’s info page.

The Indexer can also provide some context around the words to make it easier to see which results are relevant:

You can choose how many words of context will be included around the search word by changing the value in the “words of context” entry box.
6. The Highlighter

The highlighter creates a full-text version of every source text you select, highlighting the search terms in different colors to facilitate identifying relevant passages.

To run the Highlighter tool, click the “highlight it!” button:

![Highlighter Buttons]

The highlighted document opens in your browser window. Any browser works, but Google Chrome has an additional feature: if you use the browser’s search function (ctrl+F) to search for the dollar sign (“$”), the browser will display colored lines in the scroll bar for every highlighted word in the document, allowing you to identify clusters of occurrences of your search term(s). In the following example, we have highlighted the word “Fārs” in Ibn Hawqal’s *Kitāb Šūrat al‐Ard*, and the highlighting on the scroll bar clearly shows the sections of the work with a high concentration of hits:

![Highlighted Text]

For each “Highlighted” text, Jedli only saves the most recent search in the “search_results” output folder. If you want to run the Highlighter several times (for different search terms) using the same text (e.g., al‐Ṭabarī’s *Taʾrīkh*), you can save the results as an html file from the browser (right-click: “save as”).

Jedli uses its default color scheme for highlighting: yellow for the first (list of) word(s), green for the next, and so on:

![Color Scheme]

For each “Highlighted” text, Jedli only saves the most recent search in the “search_results” output folder. If you want to run the Highlighter several times (for different search terms) using the same text (e.g., al‐Ṭabarī’s *Taʾrīkh*), you can save the results as an html file from the browser (right-click: “save as”).

Jedli uses its default color scheme for highlighting: yellow for the first (list of) word(s), green for the next, and so on:
If you want to choose yourself which color is to be used for which search terms, tick the Highlighter’s “choose custom colors” checkbox. This will bring up a color choice pop-up for every (list of) search term(s):

Examples for the use of the Highlighter

The Highlighter tool can be used in a variety of ways that alter and adapt to how you read your primary sources. One possible use is the search for particular terms or details you are interested in, such as certain names, dates, or places. You can look for as many search terms and/or checklists as you like; in the html file containing your search results, you can quickly scroll through the text and, for instance, watch out for highlighted combinations of the words you were looking for. An example of this can be found in the following screenshot, which captures one result from al-Tabari’s Ta’rikh combining the search terms “al-Raqqa” and “qādi”:

Another way in which the Highlighter can enhance our reading of a text is by looking for structural elements, such as terms introducing a khabar or ḥadīth (e.g., akhbaranā, ḥaddathānī, samī‘tu), or a chapter in a chronicle (e.g., thumma dakhlat sana, bāb). This is particularly useful to quickly find where the section in which a result you are interested in, starts or ends.
7. The Context Search

The Context Search tool is a more advanced version of the Indexer. It allows you to restrict your search results to specific semantic contexts, which are defined by checklists of words.

You can define one or more primary search terms ("OR" words), which are then indexed by the Indexer. In a next step, the Context Search tool checks for each of these hits if it is in a desired context, i.e., if any of the secondary search words ("AND" words) that are likely to signal a relevant context for the primary search term(s) is located within a user-defined range of words from the primary search word. If the hit fails this test, it is excluded from the search results. In order to have even more control over the final results of your search, you can also define a number of words that should not appear in the context of the primary search words ("NOT" words).

An example will elucidate the working of the Context Search tool:

---

**Using the Context Search**

This tool was developed in the first instance to find information about provincial governors in the early Islamic empire. How we proceeded in our search for governors will illustrate how this tool can be used.

In a first step, we used the Indexer to look up all contexts in which the name of a province was mentioned in one source. We then manually selected those search results that were related to governors. In a next step, we analyzed the vocabulary composition of these search results and identified the “trigger words” in these contexts, on the basis of which we (consciously or subconsciously) had decided that the text fragment talks about a governor. The most effective trigger word was found to be ‘alā in combination with the name of the province (e.g., ‘alā Ifriqiya, “in charge of Ifriqiya”). Other trigger words included titles used for governors (e.g., wālī, ‘āmil) and terms related to appointment, dismissal, and functions of a provincial governor (e.g., wallā, wilāya, waliya, aqarra, ‘azala). We also analyzed how close to the name of the province these trigger words were located in order to define a word range that would limit irrelevant contexts while not excluding relevant contexts.

In the case of the province of Fārs, we had a problem that many irrelevant results turned up because of its homonym fāris (“horseman”). We made a list of contexts where فارس most likely refers to a horseman rather than the province (e.g., 1,000 horsemen”), and excluded these from our searches. Any time a new word turned up in our searches that indicated that فارس referred to a horseman, we added it to the checklist.

---
To use the Context Search tool, select your search words, using the buttons to the left of the input fields to indicate how you want Jedli to deal with these search words. In the example below, the Context Search will search for every mention of the word Fārs in the text. It will then select a context of 8 words (see the input field under the “context search” button at the bottom of the screen) around every occurrence of the word Fārs and check if it contains any of the words in the “key_words_governors – Fars” checklist (which we selected by clicking the “select checklist” button). If this is not the case, this hit will not be displayed in the list of result. Similarly, in case the only mention of Fārs in this context was in the word combination “alf fāris” or “miʿat fāris” (1000/100 horsemen), the result will not be considered relevant.

This is an excerpt of the html page with the results of this search in al-Ṭabarî’s Taʾrīkh that opens in your browser once Jedli finished the search:

The main search word, Fārs, is highlighted in green, the search words from the governors key word list in yellow. Jedli filtered 224 hits out of the 995 mentions of Fārs in the text; more false results could be filtered out by expanding the list of NOT words (e.g., miʿatay fārs, “200 horsemen”, on p. 49 of vol. 6).
8. The menu bar

The menu bar contains a number of additional useful functions.

a. Load and save search parameters

If you plan to use certain combinations of search terms and/or sources more often, it might be useful to save these by clicking “save search parameters” in the “File” drop-down list in the menu bar.

This will open a dialog box that allows you to choose a file name for your search parameters. After clicking OK, the following parameters will be saved in the jedli\modules\saved_searches folder:

- your search terms/checklists, each with their respective search options
- your sources
- your output folder

You can later load these same parameters again by clicking “load search parameters” in the “File” drop-down list in the menu bar.

b. Default settings

You can change Jedli’s default settings in order to speed up and personalize your searches.

To make new default settings, click “load and edit default settings” in the “Options” drop-down list in the menu bar.
This will open the following pop-up window:

![Set Default Values window]

After selecting your favorite settings, click “save and set preferences” on the bottom right of the screen, and you will be prompted to give a name to this set of preferences.

You can later load these preferences by clicking the “load preferences” button in the “Set Default Values” window. You can edit them and save them again under another name (or the same).

You can also simply load saved settings directly from the “Options” drop-down list in the menu bar by clicking “load default settings”.
c. Adding new sources to the source list

Jedli comes with a small selection of sample texts that originate from al-Maktaba al-Shamela. These texts have been converted from the epub versions that can be downloaded from their website.

If you want to add more sources to your source list, you have a couple of options. In all cases, you will have to update the sources folder before you can use these new texts in Jedli, by clicking “Update source list” in the Sources menu:

Batch download texts from the Jedli website

All available texts from al-Maktaba al-Shamela have been converted by the Jedli team to .txt format and can be downloaded via the following link:


You can either download all the texts or specific batches.

The texts are zipped; unzip the zip archive and put the .txt files into Jedli’s “text” folder:

After updating the source list (see above), you can now use the newly added texts in Jedli.
Select specific texts for download from Jedli’s “Download” window

The “Download” window in Jedli lists all the texts that are available on the Jedli website and are not yet in your sources folder. You can filter and select the sources in the same way as you do in the “Source selection” window.

You can access the Download interface in two ways:

- From the Sources menu: choose “Download sources from the Jedli website”

- With the “download additional sources” button in the Source selection window:
Download texts from al-Maktaba al-Shamela and convert them

If you want to download a text from al-Maktaba al-Shamela and convert it yourself, this is how you can go about it:

2. Once you have selected the book you want, you can download the epub file by clicking this icon:
   ![icon](right-click; “save file as”). Save the file to the Jedli epub folder (jedli\texts\epub_files).
3. Once you have downloaded all the epubs you need, you can click “epub converter” in the “Sources” drop-down list in the menu bar.

![Screen capture](epub_converter)

4. Select the epubs you want to convert and click “open”.
5. The epub files have now been converted to text files (.txt) and saved in Jedli’s text folder (jedli\texts).
6. If you want the new texts to show up in the list of sources in Jedli, click “update source list” in the “Sources” drop-down list in the menu bar. The information about author, title, date, and genre of the recently converted epub files are now added to the list.

Add texts from other sources

You can also manually add text files in .txt format to the Jedli texts folder and update the source list in the same way by clicking “update source list” in the “Sources” menu.

If your new text files do not originate from al-Maktaba al-Shamela, or do not have the original Shamela text ID number as their file name, Jedli will not be able to retrieve the author, title, date, and genre information for these files. You can add this information manually in Jedli’s source information spreadsheet (jedli\texts\source_info\source_info.xlsx):
Column A contains the name of the author, B the title of the book, C the genre (as defined by al-Maktaba al-Shamela), D the date the source was written, and E the filename (without the .txt extension).

Do not forget to click “update source list” in the “Sources” menu after adding the information for the changes to take effect.

Volume and page numbers

Jedli uses a standardized volume and page numbering system; if you want to be able to use Jedli’s Indexer and Context Search for texts that are not derived from al-Maktaba al-Shamela, you will have to adapt the formatting of the volume and page numbers to this format (at the bottom of the page):

الجزء: 11 | الصفحة: 232

A future version of Jedli will have a function to automatically format the page numbers.